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Paper Set 1 · 24 May 2026 · 9:00 AM - 10:30 AM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
Aditya and Jitya each invested ₹40,000 in a company. After 3
months, Aditya invested an additional ₹20,000 while Jitya withdrew
₹10,000. If the total profit after 12 months is ₹36,000, what is Jitya’s
share of the profit (profit is same for each month)?

A.  ₹11,500

B.  ₹13,371.43

C.  ₹12,500

D.  ₹10,567.67

✓

Q2 Quant
Which of the following ratios is the greatest among them?

13:20, 7:10, 19:30, 11:15

A.  7:10

B.  11:15

C.  19:30

D.  13:20

✓

Q3 Quant
A motor cyclist rides for 2 hours at 30 km/h and then for 2 hours at
50 km/h. What is his average speed for the entire trip?

A.  40 km/h

B.  45 km/h

C.  48 km/h

D.  35 km/h

✓

Q4 Quant
What is the solution of the following system of equations?

x + y + z = 6,
2x − y + 3z = 9,
x + 2y − z = 2.

A.  x = −1, y = 2, z = −3

B.  x = 1, y = −2, z = 3

C.  x = −1, y = −2, z = −3

D.  x = 1, y = 2, z = 3

✓

Q5 Quant
The average of 6 numbers is 45. If five of them are 40, 48, 42, 50,
and 47, find the sixth number.

A.  40

B.  43

C.  45

D.  48

✓

Q6 Quant
Two cyclists start from the same point and travel in the same
direction. Cyclist A rides at 20 km/hr, while cyclist B rides at 30 km/hr.
After 2 hours, cyclist B realises he forgot his water bottle and
immediately turns back to the starting point at 40 km/hr. Upon
reaching the start, he picks up the bottle and then starts chasing
cyclist A at 50 km/hr. Now, find the total time taken for cyclist B to
catch up with cyclist A after picking up the bottle.

A.  2 hours, 20 minutes

B.  2 hours, 40 minutes

C.  2 hours, 30 minutes

D.  2 hours, 45 minutes

✓

Q7 Quant
A shopkeeper sells an article at a loss of 15% on its cost price of
₹2,000. He then uses the selling price of this article as the cost price
of another article and sells it at a profit of 20%. What is the selling
price of the second article?

A.  ₹2,040

B.  ₹2,050

C.  ₹2,100

D.  ₹2,150

✓

Q8 Quant
A water tank is filled by three pipes in 2, 3, and 6 hours, respectively.
Determine the total time required to fill the tank if all three pipes are
opened simultaneously.

A.  0.5 hours

B.  1 hour

C.  2 hours

D.  3 hours
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✓

Q9 Quant
The median of a dataset is x and the mode is 2x (where x>0). If the
mean of the dataset is 5, then the value of x is:

A.  5

B.  7

C.  2

D.  10

✓

Q10 Quant
One pipe can fill a tank in 8 minutes while another pipe can empty
the completely filled tank in 11 minutes. If both the pipes are
opened together when the tank is empty, how many minutes will it
take to fill three-fourths of the tank?

A.  22

B.  44

C.  23

D.  45

✓

Q11 Quant
₹2017 is divided among Mansi, Suresh, and Jay such that, if ₹12, ₹40,
and ₹41 are deducted from their respective shares, the remaining
amounts are in the ratio 4 : 19 : 14. Find Jay’s original share.

A.  ₹769

B.  ₹878

C.  ₹828

D.  ₹778

✓

Q12 Quant
The diagonals PR and QS of the rectangle PQRS intersect at O. If OQ
= 4x + 5 and OR = 2x + 11, then what is the value of the product of
PR and QS?

A.  1156

B.  289

C.  484

D.  1024

✓

Q13 Quant
A tangent is drawn to a circle of diameter 14 cm from a point at a
distance of 25 cm from the centre of the circle. The length of the
tangent is:

A.  24 cm

B.  20 cm

C.  23 cm

D.  22 cm

✓

Q14 Quant
Three solid cubes of sides 3 cm, 6 cm and 9 cm are melted to form a
new solid cube. Find the total surface area of the cube so formed.
(Rounded off to the nearest integer)

A.  439 cm2

B.  589 cm2

C.  659 cm2

D.  489 cm2

✓

Q15 Quant
A scored 25% more marks than B, while C scored 20% more marks
than B. If C scored 72 marks out of 100, find the marks obtained by
A.

A.  50

B.  60

C.  75

D.  48

✓

Q16 Quant
Ram invested ₹10,000 at compound interest, compounded annually,
with the following interest rates: 6% for the first year, 9% for the
second year, and 12% for the third year. How much more or less did
he earn compared to if he had invested the same sum at 8%
compound compounded annually for 3 years?

A.  ₹343.36 more

B.  ₹343.36 less

C.  ₹353.36 more

D.  ₹353.36 less

✓

Q17 Quant
A television set has a marked price of ₹99,100. A retailer purchases it
after receiving two successive discounts of 30% and 20%. The
retailer then fixes his own marked price for the television. He allows
a discount of 44% on this marked price to the customer and still
wants to earn a profit of 50% on his cost price. At what price (in ₹)
should the retailer mark the television set?

A.  ₹1,48,650

B.  ₹1,48,689

C.  ₹1,48,576

D.  ₹1,48,542
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✓

Q18 Quant

A.  3

B.  4

C.  5

D.  6

✓

Q19 Quant

A.  24

B.  21

C.  18

D.  22

✓

Q20 Quant

A.  1

B.  

C.  

D.  
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GA

✓

Q21 GA
Which of the following teams won the Indian Premier League (IPL)
trophy in 2025?

A.  Royal Challengers Bengaluru

B.  Punjab Kings

C.  Gujarat Titans

D.  Mumbai Indians

✓

Q22 GA
Which team was crowned as the champion of the prestigious 15th
Hockey India Senior Men National Championship 2025?

A.  Punjab

B.  Madhya Pradesh

C.  Uttar Pradesh

D.  Manipur

✓

Q23 GA
Which educational achievement was awarded to two Odisha
teachers in September 2025 from Government of India?

A.  Bharat Ratna

B.  Sahitya Akademi

C.  Padma Vibhushan

D.  National Teachers’ Award

✓

Q24 GA
The Sanyasi Rebellion (1763-1800), one of the earliest revolts against
the British, took place primarily in which region of India?

A.  Punjab

B.  Bengal

C.  Awadh

D.  Mysore

✓

Q25 GA
The Bahuda River of Odisha joins the Bay of Bengal in which Indian
state?

A.  Andhra Pradesh

B.  Tamil Nadu

C.  West Bengal

D.  Uttar Pradesh

✓

Q26 GA
Maratha rule in then Orissa roughly spanned which years before
British annexation?

A.  1600–1660

B.  1707–1751

C.  1751–1803

D.  1818–1857

✓

Q27 GA
How does the continental shelf extend from the shoreline?

A.  It drops sharply into a deep trench.

B.  It remains completely flat.

C.  It gradually slopes seawards.

D.  It slopes landwards toward the coast.

✓

Q28 GA
Which of the following statements about pH in everyday life is
correct?

A.  Our stomach produces acid with pH around 9 to digest food

B.  Tooth decay occurs when mouth pH rises above 7

C.  Plants grow best when soil has a suitable pH range

D.  Rainwater with pH 7.5 is called acid rain

✓

Q29 GA
Which characteristic is typical of epithelial tissue?

A.  Presence of abundant matrix in between the cells

B.  Closely packed cells forming continuous sheets

C.  Transmission of impulses

D.  Voluntary contraction and relaxation

✓

Q30 GA
Which foundation from Odisha received the CSR Times Award 2025
(Gold category) in July 2025 for sports promotion?

A.  Odisha Sports Foundation

B.  Odisha Rural Sports Initiative

C.  Sambalpur Youth Foundation

D.  Jindal Foundation
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✓

Q31 GA
In which year did the National Disaster Management Authority
(NDMA) release the first National Disaster Management Plan
(NDMP) for India, aligning its strategies with the Sendai Framework
for Disaster Risk Reduction?

A.  2009

B.  2016

C.  2019

D.  2022

✓

Q32 GA
During the State Visit of the Philippine President to India in August
2025, which treaty on criminal justice cooperation was signed
between the two countries?

A.  Treaty on Mutual Legal Assistance in Criminal Matters

B.  Treaty on Maritime Security Cooperation in Coastal Waters

C.  Treaty on Peaceful Exploration of Outer Space Technologies

D.  Treaty on Comprehensive Economic Partnership and Trade
Relations

✓

Q33 GA
Which educational institute remained at the top in the overall
category in the latest National Institutional Ranking Framework
(NIRF) ranking released in 2025?

A.  Indian Institute of Technology, Delhi

B.  Indian Institute of Technology, Madras

C.  Indian Institute of Science, Bengaluru

D.  Delhi University

✓

Q34 GA
Which one of the following factors is mainly responsible for the
seasonal reversal of winds in India’s monsoon climate?

A.  Earth’s rotation

B.  Differential heating of land and sea

C.  Ocean currents in the Indian Ocean

D.  Movement of tectonic plates

✓

Q35 GA
In Indian context, which one of the following classical dance forms
of South India is well known for its elaborate makeup, colorful
costumes, and storytelling based on epics like the Ramayana and
Mahabharata?

A.  Odissi

B.  Kathakali

C.  Kuchipudi

D.  Manipuri

✓

Q36 GA
The reverberation time in a hall is primarily influenced by _______.

A.  Volume of the hall and nature of wall surfaces

B.  Frequency of sound only

C.  Temperature of air only

D.  Distance of audience from the stage

✓

Q37 GA
Which of the following factors causes Shimla to have a cooler
temperature than Ludhiana?

A.  Shimla is located at a higher altitude than Ludhiana.

B.  Shimla is closer to the sea than Ludhiana.

C.  Shimla receives more direct sunlight than Ludhiana.

D.  Shimla is situated farther from the Equator than Ludhiana.

✓

Q38 GA
When was the Competition Commission of India established?

A.  2002

B.  2003

C.  2005

D.  2007
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✓

Q39 GA
Which sector was chosen as the first engine of development in the
Union Budget 2025-26 presented by Union Minister for Finance and
Corporate Affairs Nirmala Sitharaman?

A.  Agriculture

B.  Education

C.  Industries

D.  Health

✓

Q40 GA
Which musical instrument was Ravi Shankar a virtuoso of?

A.  Tabla

B.  Sitar

C.  Sarod

D.  Flute

English

✓

Q41 English
Select the option that can be used as a one-word substitute for the underlined group of words.

At the antique fair, Malissa's eyes lit up when she met a person who collects coins and medals and had a rare collection of ancient coins.

A.  philatelist

B.  numismatist

C.  pugilist

D.  medallist

✓

Q42 English
Identify the INCORRECT sentence in active voice.

A.  The committee had reviewed the policy.

B.  The report was written by the analyst.

C.  The analyst wrote the report.

D.  The researchers are conducting the experiment.

✓

Q43 English
Which sentence uses the correct past continuous tense?

A.  They were playing football when it started to rain.

B.  They was playing football when it started to rain.

C.  They were play football when it started to rain.

D.  They are playing football when it started to rain.
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✓

Q44 English
Select the option that can be used as a one-word substitute for the given group of words.

A person who studies the stars and planets

A.  Astronomer

B.  Meteorologist

C.  Archaeologist

D.  Astrologer

✓

Q45 English
Read the sentence carefully and identify the incorrectly spelt word from the options.
The manager emphasized the importance of maintanance, punctuality, and confidentiality in the office.

A.  Punctuality

B.  Maintanance

C.  Confidentiality

D.  Emphasized

✓

Q46 English
Choose the most appropriate antonym of the underlined word.
Their new house had a quaint charm, although the decor seemed out of place in the otherwise modern neighbourhood.

A.  vintage

B.  contemporary

C.  alluring

D.  deafening

✓

Q47 English
Choose the word or phrase that is closest in meaning to the opposite of the word or phrase given in capital letters.

The teacher did not hesitate to REBUKE the students for cheating during the exam.

A.  Scold

B.  Admonish

C.  Praise

D.  Criticise

✓

Q48 English
Select the most appropriate proverb to substitute the underlined group of words in the given sentence.

She kept delaying her medical check-up, and by the time she went, the illness had worsened. She should have realised that doing something at
the right time prevents bigger problems later

A.  a stitch in time saves nine

B.  look before you leap

C.  time and tide wait for none

D.  empty vessels make the most noise
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✓

Q49 English
Choose the option that correctly replaces the underlined proverb in the sentence below.

He didn’t give up, even after many failures, because where there’s a will, there’s a way.

A.  people with power always succeed

B.  determination makes success possible

C.  luck decides the outcome

D.  success depends on others’ support

✓

Q50 English
Choose the correct option to complete the sentence.
The teacher ____ us that the Earth is round.

A.  told

B.  has been told

C.  tell

D.  have told

✓

Q51 English

Read the passage and answer the questions that follow.

One of the most memorable events in my school life was the annual cultural fest last year. The entire campus was decorated with vibrant colours,
and students eagerly participated in various competitions such as dance, music, and drama. I took part in a group dance performance, which
required weeks of practice and coordination. On the day of the event, the atmosphere was filled with excitement and anticipation. Our
performance was scheduled in the evening, and despite feeling nervous, we managed to perform confidently. The audience responded with loud
applause, which boosted our morale. Teachers and judges appreciated the effort and teamwork displayed by all participants. The event
concluded with a prize distribution ceremony, where our team secured the second position. This experience taught me the value of teamwork,
dedication, and self-confidence. It remains a cherished memory, reminding me of the joy of collective effort and achievement.

Identify a suitable title for the passage.

A.  The Importance of Cultural Activities in School Education

B.  A Memorable School Event and Its Lasting Impact

C.  The Challenges Faced During School Competitions

D.  The Role of Teachers in Organising School Events

✓

Q52 English
Identify the facts given in the passage.

A.  The narrator participated in a group dance performance

B.  The event was cancelled due to unexpected weather issues

C.  The narrator refused to participate in any competition

D.  The event was held without any audience or judges
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✓

Q53 English
Identify the tone of the passage.

A.  Critical and negative

B.  Humorous and exaggerated

C.  Indifferent and detached

D.  Reflective and appreciative

✓

Q54 English
Identify the structure of the passage.

A.  Argumentative discussion presenting opposing viewpoints

B.  Descriptive explanation without any personal involvement

C.  Chronological narration of an event with reflection at the end

D.  Dialogue between students about event preparation

✓

Q55 English
Select the correct summary for the passage.

A.  The passage explains only the preparation for competitions

B.  The event describes participation, success, and lessons learned

C.  The passage focuses entirely on judging and evaluation methods

D.  The event highlights problems faced during organisation

✓

Q56 English
Select the most appropriate option to fill in the blank.

The lawyer’s argument was so _____ that the opposing counsel struggled to refute it.

A.  misleading

B.  compelling

C.  ambiguous

D.  tedious

✓

Q57 English
Select the most appropriate option to fill in the blanks.

She had ____ idea for developing critical thinking skills but was reluctant to share it as she was ____ new teacher.

A.  a; a

B.  an; a

C.  a; an

D.  the; the

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q58 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

A. the sound of chirping birds
B. through the forest was
C. the early morning walk
D. and rustling leaves breaking the silence
E. a serene experience, with only

A.  EADBC

B.  ​CBEAD

C.  ADECB

D.  ABCDE

✓

Q59 English
In the given question, a statement is divided into segments. Rearrange the segments to form a coherent statement.

A. when they saw them emerge
B. they were setting out in
C. from the mist, waving cheerfully
D. search of the children

A.  ADBC

B.  BDAC

C.  CBDA

D.  ACBD

✓

Q60 English
Select the most appropriate option to fill in the blank.

The teacher had to ask him to redo the entire paragraph since his handwriting was so ________.

A.  clear

B.  illegible

C.  elegant

D.  sloppy
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Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ନି ର୍ବା ଚନଗୁ ଡି କ ପ୍ର ତି  ପାଞ୍ଚ ବର୍ଷ ରେ ଅନୁ ଷ୍ଠି ତ ହୋଇଥାଏ ।

A.  Elections are held every five years.

B.  Election held in every five year.

C.  Elections is holding each five year.

D.  The election are happens five years.

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
Sachin Tendulkar is known as the God of Cricket.

A.  ସଚି ନ ତେନ୍ଦୁ ଲକର କ୍ରି  କେଟର ଭଗବାନ ବୋଲି  ଜଣାଶୁ ଣା ଅଟନ୍ତି ।

B.  ସଚି ନ ତେନ୍ଦୁ ଲକର କ୍ରି  କେଟ ଭଗବାନ ହୋଇଛନ୍ତି ।

C.  ସଚି ନ ତେନ୍ଦୁ ଲକର କ୍ରି  କେଟ ଭଗବାନ ଜଣାଯାଏ।

D.  ସଚି ନ ତେନ୍ଦୁ ଲକର କ୍ରି  କେଟ ଭଗବାନ ମନାଯାଇଛି ।

✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
The Konark Sun Temple is famous for its beautiful stone carvings.

A.  କୋଣାର୍କ  ସୂ ର୍ଯ୍ୟ  ମନ୍ଦି ର ଏହାର ସୁ ନ୍ଦର ପଥର କାରୁ କାର୍ଯ୍ୟ  ପାଇଁ  ବି ଖ୍ୟାତ ଅଟେ।

B.  କୋଣାର୍କ  ସୂ ର୍ଯ୍ୟ  ମନ୍ଦି ର ଏହାର ସୁ ନ୍ଦର ପଥର ଖୋଦା ପାଇଁ  ପ୍ର ସି ଦ୍ଧ।

C.  କୋଣାର୍କ  ସୂ ର୍ଯ୍ୟ  ମନ୍ଦି ର ସୁ ନ୍ଦର ପଥର ଖୋଦା ପାଇଁ  ପ୍ର ସି ଦ୍ଧ ଅଟେ।

D.  କୋଣାର୍କ  ସୂ ର୍ଯ୍ୟ  ମନ୍ଦି ର ସୁ ନ୍ଦର ପଥର ଖୋଦା ପାଇଁ  ପ୍ର ସି ଦ୍ଧ ହେଲା।

✓

Q64 Odia
“କଳାକନା ବୁ ଲାଇବା ” ଏହି  ରୂ ଢି ଟି ର ଅର୍ଥ  ଚି ହ୍ନଟ କର ।

A.  ସର୍ବ ସ୍ଵ ଲୁ ଟି ନେବା

B.  ମଳି ନ ପଡ଼ି ଯି ବା

C.  ବି ପଦକୁ  ଡାକି  ଆଣି ବା

D.  ମୃ ତ୍ୟୁ ବରଣ କରି ବା

✓

Q65 Odia
“ବାଆକୁ  ବତା” ଏହି  ରୂ ଢି ଟି ର ଅର୍ଥ  ଲେଖ ।

A.  ଅତି  ବି ଶ୍ଵାସୀ

B.  କ୍ଷୀଣ ଆଶ୍ର ୟ

C.  ଅତି  ଦୁ ଷ୍ଟ

D.  କଷ୍ଟ ଅର୍ଜିତ
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✓

Q66 Odia
ବି କଳ୍ପମାନଙ୍କ ମଧ୍ୟରୁ  ଶୁ ଦ୍ଧ ବାକ୍ୟ ଥି ବା ବି କଳ୍ପଟି କୁ  ବାଛନ୍ତୁ ।

A.  ଅକ୍ଷୟ ତୃ ତୀୟା ଓଡ଼ି ଆ ଶଂସ୍କୃତି ର ରୁ ଚି ମନ୍ତ ପ୍ର ତୀକ ।

B.  ଅକ୍ଷୟ ତୃ ତୀୟା ଓଡ଼ି ଆ ଷଂସ୍କୃତି ର ରୁ ଚି ମନ୍ତ ପ୍ର ତୀକ ।

C.  ଅକ୍ଷୟ ତୃ ତୀୟା ଓଡ଼ି ଆ ସଂସ୍କୃତି ର ରୁ ଚି ମନ୍ତ ପ୍ର ତୀକ ।

D.  ଅକ୍ଷୟ ତୃ ତୀୟା ଓଡ଼ି ଆ ଶଂଶୃ ତି ର ରୁ ଚି ମନ୍ତ ପ୍ର ତୀକ ।

✓

Q67 Odia
ଡାକ୍ତରମାନେ ଅକ୍ଲା ନ୍ତ ପରି ଶ୍ର ମ କରି  ରୋଗୀଟି କୁ  ଜି ଆଇଲେ । ରେଖାଙ୍କି ତ ପଦର ସଠି କ୍  କ୍ରି  ୟାପଦ ଦର୍ଶା ଅ

A.  ସକର୍ମ କ କ୍ରି  ୟା

B.  ଅକର୍ମ କ କ୍ରି  ୟା

C.  ପ୍ରେ ରଣାର୍ଥ କ କ୍ରି  ୟା

D.  ମି ଶ୍ର  କ୍ରି  ୟା

✓

Q68 Odia
ପୁ ରାଣପଣ୍ଡା ଲୋକଙ୍କୁ  ଭାଗବତ ଶୁ ଣାଇଲେ।ଏହି  ବାକ୍ୟରେ ଥି ବା କ୍ରି  ୟା ପଦଟି କୁ  ଚି ହ୍ନଟ କର।

A.  ପୁ ରାଣପଣ୍ଡା

B.  ଲୋକଙ୍କୁ

C.  ଭାଗବତ

D.  ଶୁ ଣାଇଲେ

✓

Q69 Odia

ନି ମ୍ନୋ କ୍ତ ଅନୁ ଚ୍ଛେଦକୁ  ପଢି  ପ୍ର ଶ୍ନ ଗୁ ଡି କର ଉତ୍ତର ଚୟନ କର ।
ଗୋସ୍ଵାମୀ ତୁ ଳସୀ ଦାସଙ୍କ ସହ ଭକ୍ତପ୍ର ବର ସୂ ରଦାସ ଭେଟ ହୋଇଯାଇଥି ଲେ ମାର୍ଗ ରେ । ଅନେକ ଦି ନର ବ୍ୟବଧାନରେ ତୁ ଳସୀଙ୍କ ସହ ଭେଟ ହୋଇଥି ବାରୁ  ସୂ ରଦାସ ନି ଜକୁ  କୃ ତାର୍ଥ  ମଣି ଥି ଲେ ।
ଦୁ ହେଁ  ରାସ୍ତାପାର୍ଶ୍ୱ  ଥି ବା ଏକ ବୃ କ୍ଷ ଛାୟାରେ ବସି  ଆଧ୍ୟାତ୍ମି କ ଆଲୋଚନାରେ ମଜ୍ଜି  ଯାଇଥି ଲେ । ଆଲୋଚନାରେ ବ୍ୟସ୍ତ ଥି ଲାବେଳେ ଅଚାନକ ଏକ ହାତୀ ସମ୍ମୁଖ ଦି ଗରୁ  ଆସୁ ଥି ବାର ଲକ୍ଷ୍ୟ କରି ଥି ଲେ ।
ହାତୀଟି ର ହାବଭାବରୁ  ଏହା ଉନ୍ମ ତ୍ତ ହୋଇଯାଇଥି ବା ଜଣାପଡୁ ଥାଏ । ରାସ୍ତାରେ ଯି ବା ଆସି ବା କରୁ ଥି ବା ଲୋକେ ଭୟଭୀତ ହୋଇ ଯି ଏ ଯୁ ଆଡ଼େ ପ୍ରା ଣ ବି କଳରେ ପଳାଇ ଯାଇଥି ଲେ । ହଠାତ୍
ଲୋକଙ୍କ କଳରୋଳ ଶୁ ଣି  ଦୁ ହେଁ  ଆସନ୍ନ ବି ପଦର ଆଭାସ ପାଇଯାଇଥି ଲେ ।
ପାଗଳ ହାତୀ ସେମାନଙ୍କ ଆଡ଼କୁ  ଆସୁ ଥି ବା ଦେଖୁ  ସୂ ରଦାସ ଆତଙ୍କି ତ ଅବସ୍ଥାରେ ବସି ବା ସ୍ଥାନରୁ  ଉଠି  ପଡ଼ି ଥି ଲେ । ଖାଲି  ଉଠି  ନ ଥି ଲେ, ସେହି  ସ୍ଥାନରୁ  ପଳାଇ ଯି ବା ପାଇଁ  ପ୍ର ସ୍ତୁତ ହୋଇଗଲେ । ଏହା
ଲକ୍ଷ୍ୟ କରି  ଗୋସ୍ଵାମୀ ତୁ ଳସୀ ଦାସ କହି ଥି ଲେ- ‘ଆରେ! ଏ କ’ଣ କରୁ ଛନ୍ତି , ହାତୀକୁ  ତା ମାର୍ଗ ରେ ପଳାଇ ଯି ବାକୁ  ଦି ଅ । ନି ଜେ କାହିଁକି  ପଳାଇ ଯି ବାର ଉପକ୍ର ମ କରୁ ଛନ୍ତି  ? ଲାଗୁ ଛି  ଭଗବାନଙ୍କ
ଉପରେ ଆପଣଙ୍କର ଅଖଣ୍ଡ ବି ଶ୍ୱାସ ନାହିଁ । କ’ଣ ଦୀନଦୁଃ ଖୀହାରୀ ପ୍ର ଭୁ  ତୁ ମକୁ  ରକ୍ଷା କରି ବାକୁ  ଅସମର୍ଥ  । ତାଙ୍କର ଅପାର ଶକ୍ତି  ଉପରେ ତୁ ମର କ’ଣ ଭରସା ନାହିଁ ?’ ଏହା ଶୁ ଣି  ସୂ ରଦାସ ମୃ ଦୁ  ହସ
ହସି  କହି ଥି ଲେ, ‘ଆପଣଙ୍କ ଭଗବାନ ଧନୁ ର୍ଦ୍ଧା ରୀ (ଗୋସ୍ଵାମୀ ତୁ ଳସୀ ଦାସ ମର୍ଯ୍ୟା ଦା ପୁ ରୁ ଷୋତ୍ତମ ଶ୍ରୀ ରାମଙ୍କ ପରମ ଭକ୍ତ ଥି ଲେ । ଶ୍ରୀ ରାମ ଧନୁ ର୍ଦ୍ଧା ରୀ ହୋଇଥି ବାରୁ  ଏହା କହି ଥି ଲେ) ହୋଇଥି ବା
କାରଣରୁ  ଆପଣଙ୍କୁ  ରକ୍ଷା କରି ବାରେ ପୂ ର୍ଣ୍ଣ ସକ୍ଷମ; ହେଲେ ମୋର ଆରାଧ୍ୟ ବାଲଗୋପାଳ ଭଲା ମୋତେ କି ପରି  ରକ୍ଷା କରି ବାକୁ  ସକ୍ଷମ ହେବେ ?’ ସୂ ରଦାସ ଏହା କହି ବାର ମର୍ମ  ବୁ ଝି ପାରି ଥି ଲେ
ତୁ ଳସୀ । ସୂ ରଦାସଙ୍କର ଆପଣା ଉପାସ୍ୟଙ୍କ ଉପରେ ଅଖଣ୍ଡ ବି ଶ୍ଵାସ ଥି ଲା- ଏହା ସତ୍ୟ । ହେଲେ ଆପଣା ସୁ ରକ୍ଷା ନି ମି ତ୍ତ ବାଲଗୋପାଳଙ୍କ ଉପରେ ଭରସା କରି  ରହି ବାକୁ  ଉଚି ତ ମଣି ନଥି ଲେ । ଏହି
କାରଣରୁ  ଉନ୍ମ ତ୍ତ ହାତୀ କବଳରୁ  ରକ୍ଷା ପାଇବା ପାଇଁ  ସେଠାରୁ  ଖସି  ଯି ବାକୁ  ଉଚି ତ ମଣି ଥି ଲେ । ଏହାର ସାରମର୍ମ  ହେଲା ଈଶ୍ଵରଙ୍କୁ  ଯି ଏ ଯେଉଁ  ରୂ ପରେ ଶ୍ର ଦ୍ଧାର ସହ ଦେଖୁ ଥାନ୍ତି , ସେହି  ରୂ ପ ତାଙ୍କ
ହୃ ଦୟରେ ଦୃ ଢ଼ ସ୍ଥାନ ନେଇଥାଏ ଓ ସେହି  ରୂ ପରେ ପୂ ଜା କରି ବାରେ ଆନନ୍ଦ ପାଉଥାନ୍ତି  ।

ଅନୁ ଚ୍ଛେଦରେ ଥି ବା 'କଳରୋଳ' ଶବ୍ଦର ଅର୍ଥ  କ’ଣ ?

A.  ପକ୍ଷୀମାନଙ୍କ କାକଳି

B.  ଅନେକ ଲୋକଙ୍କର ମି ଳି ତ ଚି ତ୍କାର

C.  ହାତୀର ଗର୍ଜ ନ

D.  ବାଦ୍ୟଯନ୍ତ୍ରର ଶବ୍ଦ
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✓

Q70 Odia
ଏହି  ଅନୁ ଚ୍ଛେଦଟି ର ସ୍ୱର ଚି ହ୍ନଟ କର?

A.  ସମାଲୋଚନାତ୍ମକ

B.  କୌତୁ କି ଆ

C.  ବ୍ୟଙ୍ଗାତ୍ମକ

D.  ଆଧ୍ୟାତ୍ମି କ

✓

Q71 Odia
ଅନୁ ଚ୍ଛେଦ ଅନୁ ଯାୟୀ, ଗୋସ୍ଵାମୀ ତୁ ଳସୀ ଦାସ କେଉଁ  ଭଗବାନଙ୍କର ପରମ ଭକ୍ତ ଥି ଲେ ?

A.  ଶ୍ରୀ କୃ ଷ୍ଣ

B.  ଶି ବ

C.  ଧନୁ ର୍ଦ୍ଧା ରୀ ଶ୍ରୀ ରାମ

D.  ବାଲଗୋପାଳ

✓

Q72 Odia
ଏହି  ଅନୁ ଚ୍ଛେଦ ପାଇଁ  ଉପଯୁ କ୍ତ ଶୀର୍ଷ କଟି  କ’ଣ ହେବ ?

A.  ପାଗଳ ହାତୀର ଆତଙ୍କ

B.  ତୁ ଳସୀ ଓ ସୂ ରଦାସଙ୍କ ଭେଟ

C.  ଭାବ ଅନୁ ଯାୟୀ ଭଗବାନ

D.  ଶ୍ରୀ ରାମ ଓ ବାଲଗୋପାଳଙ୍କ ଯୁ ଦ୍ଧ

✓

Q73 Odia
ସୂ ରଦାସ କେଉଁ  କାରଣ ପାଇଁ  ନି ଜକୁ  ‘କୃ ତାର୍ଥ ’ ମଣି ଥି ଲେ ?

A.  ହାତୀ କବଳରୁ  ବଞ୍ଚି ଯାଇଥି ବାରୁ  ।

B.  ଅନେକ ଦି ନ ପରେ ତୁ ଳସୀ ଦାସଙ୍କ ସହ ଭେଟ ହୋଇଥି ବାରୁ  ।

C.  ବାଲଗୋପାଳଙ୍କ ଦର୍ଶ ନ ପାଇଥି ବାରୁ  ।

D.  ଗଛ ମୂ ଳେ ବସି ବାକୁ  ସୁ ଯୋଗ ପାଇଥି ବାରୁ  ।

✓

Q74 Odia
"ତୁ ମେ ଏବେ ଆସ" ଏହି  ବାକ୍ୟରେ କ୍ରି  ୟା ବି ଶେଷଣ ପଦଟି  କି ଏ?

A.  ତୁ ମେ

B.  ଏବେ

C.  ଆସ

D.  କୌଣସି ଟି  ନୁ ହେଁ

✓

Q75 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  'ଅଗ' ଶଦ୍ଦର ବି ପରୀତ କେଉଁ ଟି  ?

A.  ଶୀର୍ଷ

B.  ମୂ ଳ

C.  ଆରମ୍ଭ

D.  ଶେଷ
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Computer

✓

Q76 Computer
Which of the following is NOT a typical pointing input device?

A.  Mouse

B.  Joystick

C.  Barcode reader

D.  Trackball

✓

Q77 Computer
When connecting LANs in a wide area network (WAN), which of the
following devices is most frequently used?

A.  Modem

B.  Router

C.  Switch

D.  Hub

✓

Q78 Computer
In which range of years was the first generation of microprocessor
founded?

A.  1971-73

B.  1954-57

C.  1981-95

D.  1958-64

✓

Q79 Computer
In the context of real-time internet communication technologies,
which term accurately describes the method used for transmitting
audio content over IP networks, such as during online calls or video
conferences?

A.  Virtual over Internet Protocol

B.  Voice on Internal Protocol

C.  Voice over Internet Protocol

D.  Visual over Integrated Platform

✓

Q80 Computer
Which Excel view allows you to adjust row height and column width
using inches, centimeters, or millimeters?

A.  Page Layout view

B.  Normal view

C.  Custom view

D.  Page Break Preview

✓

Q81 Computer
Which PowerPoint view displays the slide, outline, and notes area
together?

A.  Slide Sorter View

B.  Slide Show View

C.  Outline View

D.  Normal View

✓

Q82 Computer
What is the full form of 'LAN' in computer networking?

A.  Large Area Network

B.  Local Access Node

C.  Local Area Network

D.  Logical Access Network

✓

Q83 Computer
Which of the following archive formats is NOT supported in
Windows 11?

A.  ZIP

B.  Z

C.  7z

D.  TAR

✓

Q84 Computer
Which component of MS Word allows users to input and format text
directly?

A.  Ribbon

B.  Document Window

C.  Status Bar

D.  Quick Access Toolbar

✓

Q85 Computer
In the function ADDRESS(row_num, column_num), what does
'row_num' represent?

A.  The name of the row

B.  The column number to reference

C.  The numeric value of the row in the worksheet

D.  The worksheet name
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✓

Q86 Computer
How can you change the default ruler units in MS Excel?

A.  Home > Format > Units

B.  File > Save As > Settings

C.  File > Options > Advanced > Display

D.  View > Zoom > Unit Settings

✓

Q87 Computer
Which feature in MS Word allows you to see how a document will
look when printed, before actually printing it?

A.  Save As

B.  Layout View

C.  Print Preview

D.  Outline View

✓

Q88 Computer
Ananya is working on a slide where she needs to add a short
paragraph and later update a few words. Which area on the slide
allows her to type and modify the content directly?

A.  Slide Master title bar

B.  Animation pane

C.  Text placeholder in the slide layout

D.  Slide Sorter view

✓

Q89 Computer
Which of the following commands is use to make a copy of the
selected slide in MS PowerPoint?

A.  Ctrl + Shift + D

B.  Ctrl + Alt + O

C.  Ctrl + O

D.  Ctrl + D

✓

Q90 Computer

Identify the highligheted list as shown in the above figure form the following options.

A.  Single List

B.  Bulleted List

C.  Numbered List

D.  Multilevel List
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Q91 Reasoning
A, C, E, F, H, J, and L are sitting around a circular table, facing the
centre. F sits third to the right of J. C sits second to the left of E. Only
two people sit between F and C when counted from the left of C. A
sits to the immediate left of H. Who is sitting to the immediate left of
L?2185

A.  F

B.  J

C.  A

D.  E

✓

Q92 Reasoning
Each of C, D, E, F, G, H and I has an exam on a different day of a
week, starting from Monday and ending on Sunday of the same
week. C has exam on Thursday and I has exam on Saturday. G has
exam just before D. F has exam on one of the days after H. E has
exam just after D.
Who has exam on the last day of the week?

A.  C

B.  E

C.  F

D.  I

✓

Q93 Reasoning
BPLY is related to QEAN in a certain way based on the English
alphabetical order. In the same way, JXTG is related to YMIV. To
which of the following options is CQMZ related, following the same
logic?

A.  RFBO

B.  ROFB

C.  RBHY

D.  ROKJ

✓

Q94 Reasoning
What should come in place of ? in the given series based on the
English alphabetical order?

RBJ MWE HRZ CMU ?

A.  XHO

B.  XHP

C.  XFR

D.  XDE

✓

Q95 Reasoning
What will come in the place of ‘?’ in the following equation, if ‘+’ and
‘−’ are interchanged and ‘×’ and ‘÷’ are interchanged?

59 ÷ 2 + 39 × 3 − 5 = ?

A.  110

B.  120

C.  155

D.  175

✓

Q96 Reasoning
In a certain code language,
A @ B means ‘A is the son of B’
A & B means ‘A is the sister of B’
A # B means ‘A is the daughter of B’
A % B means ‘A is the brother of B’

Based on the above, how is P related to T if ‘P # Q % R & S @ T’?

A.  Son’s daughter

B.  Daughter’s daughter

C.  Sister

D.  Daughter

✓

Q97 Reasoning
In a certain code language, 'GMDY' is coded as '64' and 'THID' is
coded as '56'.
What is the code for 'SBEJ' in the given code language?

A.  55

B.  51

C.  59

D.  62

✓

Q98 Reasoning
Read the given statement(s) and conclusions carefully. Assuming
that the information given in the statements is true, even if it
appears to be at variance with commonly known facts, decide which
of the given conclusions logically follow(s) from the statement(s).
Statement: Some Fictions are Nonfictions. Some Nonfictions are
Poetries.
Conclusion I: Some Fictions are Poetries
Conclusion II: No Fictions are Poetries3957

A.  Only conclusion (I) follows

B.  Only conclusion (II) follows

C.  Neither conclusion (I) nor (II) follows

D.  Both conclusions (I) and (II) follow
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Q99 Reasoning
Based on the English alphabetical order, three of the following four
letter-clusters are alike in a certain way and thus form a group.
Which is the letter-cluster that does NOT belong to that group?
(Note: The odd one out is not based on the number of
consonants/vowels or their positions in the letter-cluster.)809

A.  TZY

B.  PVU

C.  LRQ

D.  KQO

✓

Q100 Reasoning
Refer to the following series and answer the question (All numbers
are single digit numbers only. Counting to be done from left to
right.)
(Left) 4 2 5 9 8 6 5 8 7 2 6 9 7 5 8 2 5 8 7 4 6 9 2 5 6 2 1 6 9 (Right)
How many such odd digits are there each of which is immediately
preceded by an odd digit and also immediately followed by an even
digit?

A.  More than three

B.  One

C.  Two

D.  Three

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in

	Front & About
	Question Paper  ·  24 May 2026  ·  9:00 AM - 10:30 AM
	QMaths · rank.qmaths.in

